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1 Features

1.1 Basic Concept

FX Graph is a dead simple, but powerful, graphing program.  It is designed to be
used, with minimal training, by twelve and thirteen year old students but is
powerful enough to support the graphing needs of all secondary school students.

2 Licence Statement

2.1 General Conditions

IMPORTANT – Read before installing, copying or using
Do not use or load this software and any associated materials (collectively, the
"Software") until you have carefully read the following terms and conditions. By
loading or using the Software, you agree to the terms of this Agreement. If you do
not wish to so agree, do not install or use the Software.

General Conditions
1. You may not copy, modify, rent, sell, distribute or transfer any part of the

Software except as provided in this Agreement, and you agree to prevent
unauthorized copying of the Software.

2. You may not reverse engineer, decompile, or disassemble the Software.
3. The Software may contain the software or other property of third party

suppliers, some of which may be identified in, and licensed in accordance
with, any enclosed "license.txt" file or other text or file.

2.2 Individual Licence

You may copy the Software onto a single computer for your personal use, and
you may make one back-up copy of the Software, subject to these conditions:
1. You may not sublicense or permit simultaneous use of the Software by
more than one user.
2. An institution may upgrade its individual licence to a full site licence or
distribution licence by negotiation with Chartwell-Yorke, www.chartwellyorke.com.

2.3 Full Site Licence

A full site licence allows the institution to place copies of the software on as many
computers as required within the institution.  The software may be in use on all of
these computers concurrently.  The software may not be distributed to students or
customers for use outside the institution or on a personal computer within the
institution.

Special Note
Efofex considers use, at home, by a teacher employed at an institution holding a
Full Site Licence to be fair use PROVIDING such use is solely restricted to
producing materials for use within the institution.
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2.4 Distribution Licence

A distribution licence allows the institution to place copies of the software on as
many computers as required within the institution and allows the institution to
distribute the software to persons directly associated with the school (eg.
students, teachers, administration staff, gardeners ...) at no extra charge to the
institution.  Efofex Software gives a school holding a distribution licence the right
to charge a fee of not more than $15 (Australian) per copy to cover the costs of
distribution

Distribution of the registration code must NOT be carried out in a publicly
accessible manner.  In particular distribution must NOT occur through a web page
that is accessible by people not linked to the institution.

2.5 Details

Ownership of Software and Copyrights
Title to all copies of the Software remains with Efofex Software or its suppliers.
The Software is copyrighted and protected by the laws of Australia, the United
States and other countries, and international treaty provisions. You may not
remove any copyright notices from the Software. Efofex Software may make
changes to the Software, or to items referenced therein, at any time without
notice, but is not obligated to support or update the Software. Except as
otherwise expressly provided, Efofex Software grants no express or implied right
under Efofex Software patents, copyrights, trademarks, or other intellectual
property rights. You may transfer the Software only if the recipient agrees to be
fully bound by these terms and if you retain no copies of the Software. Distribution
Licences are not transferable without agreement, in writing, from Efofex Software.

Upgrades
Upgrades to the software do not constitute a new product and do not purchase a
new licence.  Old versions of the software cannot be transferred to a new owner.

Limited Media Warranty
If the Software has been delivered by Chartwell-Yorke on physical media, Chartwell-
Yorke warrants the media to be free from material physical defects for a period
of ninety (90) days after delivery. If such a defect is found,
return the media to Chartwell-Yorke for replacement or alternate delivery of the
Software as Chartwell-Yorke may select.

Exclusion of Other Warranties
EXCEPT AS PROVIDED ABOVE, THE SOFTWARE IS PROVIDED "AS IS"
WITHOUT ANY EXPRESS OR IMPLIED WARRANTY OF ANY KIND
INCLUDING WARRANTIES OF MERCHANTABILITY, NON INFRINGEMENT,
OR FITNESS FOR A PARTICULAR PURPOSE.  Efofex Software does not
warrant or assume responsibility for the accuracy or completeness of any
information, text, graphics, links or other items contained within the Software.
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Limitation of Liability
IN NO EVENT SHALL EFOFEX SOFTWARE OR ITS SUPPLIERS BE LIABLE
FOR ANY DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION,
LOST PROFITS, BUSINESS INTERRUPTION, OR LOST INFORMATION)
ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE,
EVEN IF EFOFEX SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. SOME JURISDICTIONS PROHIBIT EXCLUSION OR
LIMITATION OF LIABILITY FOR IMPLIED WARRANTIES OR
CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATION
MAY NOT APPLY TO YOU. YOU MAY ALSO HAVE OTHER LEGAL RIGHTS
THAT VARY FROM JURISDICTION TO JURISDICTION.

Termination of Agreement
Efofex Software may terminate this Agreement at any time if you violate its terms.
Upon termination, you will immediately destroy the Software or return all copies of
the Software to Efofex Software.

Applicable Laws
Claims arising under this Agreement shall be governed by the laws of Western
Australia, excluding its principles of conflict of laws and the United Nations
Convention on Contracts for the Sale of Goods. You may not export the Software
in violation of applicable export laws and regulations. Efofex Software is not
obligated under any other agreements unless they are in writing and signed by an
authorized representative of Efofex Software.

2.6 Notes

· A Full Site licence allows you to use the Efofex product on any computer within
the institution.

· A Distribution licence, in addition to the rights provided in a Full Site Licence,
allows you to provide copies of the Efofex product to any person associated
with the institution.  You are NOT permitted to provide the software to another
institution.

· Most of the documentation is provided in PDF format.  The Adobe Acrobat PDF
reader is available as a free download from the Adobe site (www.adobe.com)
and is included on our distribution CD.

· You may need to provide printed versions of some sheets to students who do
not have Internet access.  You are licensed to provide these printed versions.

· To distribute the product you will need to provide a copy of the downloaded
executable AND your registration code.  You may, at your discretion, charge a
fee of up to $15 Australian to cover the costs incurred in distribution.

· If your institution makes a small profit distributing the software it is the
institution's to keep and Efofex Software makes no claim to it.

· Copies distributed under a distribution licence need not be returned when the
person leaves the institution.

· The distribution licence is not limited in duration or number.  Your institution
may distribute this program indefinitely, to anyone associated with the
institution, without further cost.  Efofex Software may, at our discretion, charge
an UPGRADE FEE for any future versions of the software that provide
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significant improvements to the program's functions.  We will provide minor
upgrades or maintenance releases as a FREE download from our Web site.
You are under NO obligation to purchase any future upgrades and may
continue to distribute the current version indefinitely.

· The institution is free to choose a convenient mode of distribution BUT Efofex
Software specifically disallows any method which makes the REGISTRATION
CODE accessible to people not associated with the institution.  In particular we
disallow the distribution of the REGISTRATION CODE as a download from a
publicly accessible web page.

· Efofex requests that you do NOT ask students to download their copy from our
web site.  Currently we do not have the capability to serve large numbers of
downloads.  You are permitted to place a copy of the download on YOUR web
site and make that copy available for download by your students.

· This information is provided for your convenience and does not override any
statement in the full licence descriptions.

3 Installation

3.1 System Requirements

FX Graph will run on any computer running Windows 95 or later.  FX Graph is
compatible with Windows 95/98/Me/NT/2000 and XP.

3.2 Installing FX Graph on Your Computer

To install FX Graph onto your system:
· Put the CD into your computer.
· If the CD does not Auto run,

Win 95/98/NT/2000/XP Choose Run from the Start menu
Type d:\setup Where d is your CDRom's drive letter.

· Push the Products button
· Push the Install FX Graph button

The install program will ask you which directory you would like FX Graph to be
placed in and will then make all necessary adjustments to your system.

The CD will install a time-limited version of the product.  If you do not enter
registration information within 30 days of installation, the product will begin to
operate in evaluation mode.  If you have purchased a registration for FX Graph,
you should have received a Registration Sticker and CD booklet with your copy of
the software that explains the registration process more fully.

3.3 Installation Notes

3.3.1 Administrator Privileges

FX Graph needs to write to the registry to do its job.  On some systems you might
require administrator privileges to achieve this.  Your IT supervisor will be able to
do this.
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3.3.2 Adding To Word

Adding FX Graph to Word is automatic.  You need to know which version of Word
you are using and make sure you select the correct option in the setup program.

We recommend that Word is not running when you install FX Graph.

3.3.3 Registration

If you are evaluating the software and wish to purchase:

· Choose the licence you require.  For a full description of the licences
available, read the licence information file on this disk.

· Contact Efofex or your local distributor by post, fax or email for the latest
prices.  Alternatively the latest prices are available from our web site at
www.efofex.com

· Purchase a registration code from Efofex or your local distributor and use
the instructions below to register your copy.

If you have purchased the software and have received a CD with attached
Registration Information:

You have all the information necessary to register your copy of the software.

To Register your copy:

· From the Help menu of FX Graph, choose Register FX Graph...
· Press the Register Now! button.
· Type in your Registered Name and Registration Code EXACTLY as

supplied by Efofex.  You MUST enter your registered name using the
same abbreviations, even the same spelling errors (if we have made any)
as the registered name we have supplied.

FX Graph will now operate correctly past the thirty day evaluation period.

3.3.4 Adobe Acrobat

All manuals are provided in Adobe Acrobat PDF format.  In order to read and print
the manuals you will need to obtain a copy of Acrobat Reader V3.0 or later.

The Acrobat reader is available as a free download from www.adobe.com and is
included on our CD.

Before downloading a copy of the reader, try clicking on the supplied PDF files.
You are quite likely to already have a copy of Acrobat Reader installed on your
system.
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3.3.5 Changes FX Graph Makes (Advanced)

A standard installation of FX Graph makes the following changes to a system.

· FXG300.exe, word documents and templates, PDF versions of manuals
and quick reference cards, an uninstall program and log are all placed in
the installation directory (c:\Program Files\Efofex\FXG3 by default).

· FX Graph's uninstall information is included in the Add/Remove Programs
section of Control Panel.  This can be disabled by removing the uninstall
program and log from the installation subdirectory.

· FX Graph registers itself as an OLE object in the registry
(HKEY_CLASSES_ROOT).

· Registration information is stored in an ini file saved to the All Users profile.
(c:\Documents and Settings\All Users\Application Data\Efofex is a likely
location).  If FX Graph cannot determine profile information, it will store the
ini file in FX Graph's application directory.

· Individual users preferences are stored in a .ini file that is saved into their
profile. (c:\Documents and Settings\%username%\Application Data\Efofex
is a likely location).  This file also contains any entered registration
information.  Copying this file to the Default User profile or All Users profile
can assist in network installations.  If FX Graph cannot determine profile
information, it will store the ini file in FX Graph's application directory.

· Word macros and toolbars are stored in FXGraph3.dot.  By default, this file
is placed in Word's application startup directory (C:\Program
Files\Microsoft Office\Office\Startup for example).  In networked
installations, you may wish to move this file to another startup directory –
see below for details.  This file has been digitally signed by Efofex
Software and must be trusted to install.

· It is likely that installation of FX Graph will require Administrator privileges.

3.3.6 Automatic Registration and Configuration (Advanced)

FX Graph has a number of built-in systems that make automatic registration and
configuration easy.

Simple Configuration File
FXG300.ini is a normal .ini file that can be copied into anyone's profile or
placed into the default user profile.

Default Configuration & Registration System
At any stage, you can write a default configuration file.  Set up a registered
copy of FX Graph and choose Write Default Configuration File from the
Tools menu.  This file, FXG3_Default.ini, will be written to FX Graph's
application directory.  This file can greatly simplify your installation.
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When FX Graph first starts, it checks to see if there is a Default
Configuration file in its directory.  If there is, it loads all the options from the
file, saves these options into the user's profile, and then attempts to delete
the default configuration file.  No error is generated if FX Graph cannot
delete the file.  This behaviour means that you can use the default
configuration file in one of two ways:

· Ensure that there is a copy of FXG3_Default.ini in FX Graph's directory
and let it customise FX Graph for you.  Once it is automatically
deleted, the user is free to customise their copy of FX Graph.

· You can make FXG3_Default.ini read only (or make it part of the
standard operating environment) so that FX Graph is ALWAYS reset
back to your standard configuration when it is run.

Integrate with Word
Configuring Word involves copying FXGraph3.dot into a startup directory
that is accessible to the user.  Word, by default, loads all templates that
are located in a startup directory.  There are three startup directories that
can be used.

· The application has its own startup directory.  This will often be
C:\Program Files\Microsoft Office\Office\Startup but this obviously
depends on your setup.  The FX Graph setup program will
automatically copy the FXGraph3.dot into this directory.

· The All Users profile has a Word startup directory.  This will often be
C:\Documents and Settings\All Users\Application
Data\Microsoft\Word\STARTUP.

· Each user has a Word startup directory.  This will often be
C:\Documents and Settings\%username%\Application
Data\Microsoft\Word\STARTUP

You should only have the FXGraph3.dot file in ONE of these locations.

Locking Preferences
You can prevent users from accessing the Tools/Preferences menu,
writing Default Configuration files and resetting all options.

· Open your standard FXG300.ini in an editor (eg Notepad)

· Find AllowPreferenceChanges=1 and change it to
AllowPreferenceChanges=0

· Save FXG300.ini
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4 FX Graph and Word

4.1 Adding FX Graph to Word

Adding FX Graph to Word is handled automatically by the installation program.
When you first use Word after installing FX Graph, you may be asked if you trust
the document and macros that have been signed by Efofex Software.  You MUST
trust the macros if you are to use FX Graph properly.

When you open Word you will see a new toolbar with an FX Graph button.

The button inserts a new graph into your document.

4.2 Using FX Graph in Microsoft Word

FX Graph is designed to be used in Word to generate publication quality graphics
for tests, examinations, worksheets and assignment.  The easiest way to insert
graphics into Word is:

· Push the toolbar button
· Type in your structure into the box at the top and see it displayed, fully

formatted, in the lower half of the window.
· Click the Green tick

Alternatively you can use Insert Object from the Insert menu in Word and select
FX Graph 3 Graph.

When you insert an FX Graph object into your document, FX Graph will start and
you can use it in the same way you use FX Graph as a standalone program.  The
only real difference is how you return to Word.

The green tick will return your image to Word showing all changes you have
made.  The red cross returns to Word without any changes being updated.

Once you have finished drawing your structure, push the appropriate button to
return to Word.
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5 Using FX Graph

5.1 Accessing FX Graph

There are two main ways of using FX Graph – as a standalone program, or as an
object from within a word-processor or other "object aware" program.

Standalone Mode
If you accept FX Graph default installation, you can run it as a standalone
program by finding FX Graph in the Program Files section of the Start menu.
This is often the best way of using FX Graph, especially with students.

Document Object Mode
FX Graph is designed to be inserted as an object into a document.  You can
insert an FX Graph object into a document by either pushing the FX Graph
toolbar button (see the section on using FX Graph in Word) or load your favourite
Windows word processor and choose Insert / Object from the menus.  You will be
given a list of available objects and FX Graph 3 Graph will be on the list.  Select it
and FX Graph will start.  You use it the same way you use FX Graph as a
standalone program.  The only real difference is how you return to Word.

The green tick will return your image to Word showing all changes you have
made.  The red cross returns to Word without any changes being updated.

When you have finished your image, just "Click the Tick" and your diagram will
be inserted into your word document.
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5.2 Getting Started

When you first start FX Graph, you will see a blank set of axes.

We believe that large numbers of options just confuse students and we have
designed FX Graph with as simple an interface as possible.

To start entering functions, either

Push the  button
or Click the right mouse button
or Choose Edit/Functions from the menus

The Quick Entry screen will appear.  This screen is your gateway to FX Graph.

5.3 Quick Entry Screen

The Quick Entry screen gives you access to most of the capabilities of FX Graph
in a quick and simple manner.  You can achieve much greater control over FX
Graph's output using its other interfaces but you will spend most of your time
using this screen.
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Function Entry Area
Enter your functions - one per line - in this area.  FX Graph's function entry
utilizes our equation technology which is discussed in more detail later in this
manual.

Function Display
Displays the currently selected function using our equation technology.  Notice
how the x2+y2=4 that we typed has been converted to a formatted equation.

Axis Control
Provides basic, extremely fast, control over the axis settings for FX Graph.
Setting the axes using this system is a two stage process.

1. Set the SHAPE you require using the two sliders.
2. Set the MAXIMUM x and y values.

FX Graph does everything else automatically.

Angle Type
Degrees, Radians and Grads can be set here.

Greater Control
The Functions, Axes and Grid buttons give you much greater control over the
output of FX Graph.

More Options
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The More >> button expands the screen and provides access to more options - in
this case Feasible Region settings.  Many of FX Graph's screens contain a More
>> button.

This diagram shows the Quick Entry screen with the More >> button depressed.
Notice that we have set the axes to a different shape and set the x Max to 2pi.
This forces FX Graph to mark the x scale in fractional parts of pi.

Axis Annotations
By default, FX Graph marks the axes as x and y.  You can change these
annotations here.

Show Grid
Turns the grid on and off.

Auto Scale
Autoscaling makes the setting of the axes even easier.  If this box is checked, FX
Graph will automatically detect any points of interest (local maxima and minima, x
intercepts and intersections) from -500 to 500 and adjust the axes so that all of
the points of interest are visible.  Once you have selected Autoscaling, FX Graph
takes full responsibility for the axes.  Please note that the autoscaling feature
slows down the response time of FX Graph.

Feasible Region Options
These settings are discussed in the Inequations & Feasible Regions section of
the manual.
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5.4 Function Entry

FX Graph uses the equation engine from FX Equation so entering functions is
extremely easy AND you can see a fully formatted version of your function as you
type.

Functions are entered into FX Graph by typing what you see WITHOUT any
formatting.  On most occasions FX Graph will automatically format your function
for you.

For example.  If you want to graph the function 3x
3
 + 2x

2
 - 7 simply enter

3x3+2x2-7 into the function entry area.  FX Graph automatically recognises and
formats the powers and displays the formatted function for you to check your
entry.
Simple fractions are also entered as you see them.  In other words if you want to
graph

you enter 3x3/2x4 and FX Graph will automatically build the appropriate fraction.
Most simple functions can be entered this way, with NO formatting on your part.
More complicated functions will require some limited extra input on your part.

Regional Issues:

FX Graph automatically detects which style of decimal point you use (3.2 or 3,2).
If you use a , as a decimal point, you must use a semi colon to separate
coordinates in points and vectors (eg (3,2; 1,7) ) and a colon to separate domains
from functions or the two components of parametric functions.

5.5 Special Points About Function Entry

Because of the restrictions of a computer interface, there are some special points
you will need to understand to enter all functions.

Special Symbols
Because mathematicians use many symbols not normally found on a computer
keyboard, FX Graph uses a small number of special symbols, codes and
abbreviations in order to allow you to enter functions.
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Normal
Symbol

FX Graph Notes

Multiplication ´ *

Exponentiation
(Powers)

none (eg 2x) ^ (eg 2^x) Only needed when FX
Graph fails to
automatically
recognise the power.

Division ¸ / (followed by a
space)

The / character is more
often used (without the
space) to enter
fractions.

Pi p pi Can be used in both
functions and axes.

Theta q th Used in polar functions

Greater than or equal
to

³ >=

Less than or equal to £ <=

Plus Minus ± +- FX Graph will
automatically graph
both arms of the
function.

Most of these symbols are in common use in computer based mathematics.

Brackets
Many functions, especially fractions, contain assumed brackets.  FX Graph will
sometimes require you to enter these brackets even though you cannot see them.
For example,  if you enter y = 3/x+3 does this mean

 

To graph the second function you need to add logical brackets to your function
and type  y = 3/(x+3).  These brackets will not be displayed but will influence how
your function is interpreted.

As a general rule, if the function is not shown formatted correctly by FX Graph,
add some brackets to make your meaning clear.

A very important use of brackets is to logically identify the numerator and
denominator in complicated fractions. For example: (x+2)/(x-3) needs the

brackets to be interpreted as    rather than  .

Brackets are also used to logically identify powers and ensure that FX Graph
interprets your function correctly.

All three bracket types {, [ and ( may be used interchangeably in FX Graph and
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FX Graph makes no distinction between them.  FX Graph does not even check to
see if brackets are paired.  You are responsible for this.  If there is a fraction
inside a bracket, the bracket is automatically resized.

Example:

 is entered as 3[(x-2)2+1/2]

Powers
Most powers will be automatically recognized by FX Graph.  FX Graph will not
automatically recognize powers if

· you require a variable as a power
· you require a function as a power
· you require a power of a number
· you require a complicated power.

In these cases you need to explicitly indicate the power using the ^ symbol.  As
with fractions, complicated powers need to be surrounded with brackets.  These
brackets will not be displayed.

Examples:

 is entered as e^sinth

 is entered as x^(2y+3)

Spaces
Spaces change the way a particular equation is formatted and therefore
interpreted.  This can best be illustrated using these examples.

 is entered as sin2  th

 is entered as sin  2th

The only difference between the two equations is the location of a space.

5.6 Types of Functions

5.6.1 Cartesian

Normal Cartesian functions (y = ...) can be entered into FX Graph with or without
the y=.

y = 3x - 7

OR

3x - 7
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Normal Cartesian functions are the most supported type of in FX Graph.
Cartesian functions are REQUIRED for some of FX Graph's features.

FX Graph will rearrange functions into normal Cartesian functions if possible.

For example:

3x2 + y = 3x + 2

will be internally rearranged by FX Graph into:

y = -3x2 + 3x + 2

and all features will be available.

In the diagram above, notice how we entered the function as 3x2 + y = 3x + 2 but
FX Graph has rearranged the function when finding the integral.

5.6.2 "Two Armed" Functions

FX Graph supports the use of ± in functions.
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5.6.3 Polar

Polar functions are entered in terms of r and q.  Because there is no q key on a
computer keyboard, FX Graph uses th to represent q.

You can enter a normal polar equation such as r = 5 sin 3q by typing

r = 5 sin 3th

or

5 sin 3th

The r = is optional and will be assumed if you do not enter it.

FX Graph can also draw inverse Polar functions - just enter them in terms of r.

th = 3r

th = 1/r

th = pi/4

Don't forget that FX Graph can draw polar grids.
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5.6.4 Inverse

Inverse Cartesian functions (x = ) can be entered as

x = 3y2+3y-4

or

3y2+3y-4

the x = is optional
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FX Graph will rearrange functions if possible.  3xy + y = 4x  will be internally
rearranged into y = 4x/(3x+1) to provide access to more of FX Graph's features.

5.6.5 Implicitly Defined

Implicitly defined functions are treated in two stages.

1. FX  Graph tries to rearrange the function to be in terms of

y =
x =
y2 =
x2 =

and will then graph the function.

2. If FX Graph CANNOT rearrange the function, it uses a more generalised
approach to graphing.  For example,

x/y2+y/x2 = 1
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This approach basic looks for equality between the two sides of the equation.
When using this form of graphing, FX Graph CANNOT perform detailed analysis
of the curve.

5.6.6 Parametric

Parametric curves are entered as two equations in terms of t - separated by a
semicolon (see regional issues).

x = 6cos t ;  y = 6sin 3t
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Regional Issues

If you use a comma as a decimal point (eg 3,2) you must use a colon to separate
the two parts of a parametric equation.

x = 6cos t :  y = 6sin 3t

5.6.7 Points

Points are entered as ordered pairs - optionally separated by semicolons (see
regional issues).

(2,3) (1,1); (-1,-1) (-3,2)
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By prefixing one of the points by a P, FX Graph will interpret all of the points as
being in polar form, (r, q).  When entering points in polar form, you need to enter
the angle in the currently selected angle type.

P(6,pi/4) (3,3pi/4) - angle set to Radians
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Constants

Points can contain constants which are discussed later in this manual.  You can
enter a point of (-3a,b) for example.

Regional Issues

If you use a comma as a decimal point (eg 3,2) you must use a semicolon to
separate the two coordinates and (optionally) a colon to separate the individual
points.

(2;3) (1,1;1,1) : (-1;-1) (-3;2)

5.6.8 Groups of Points

FX Graph can plot groups of points and join them together.  Simply place a + sign
between the points. See regional issues.

(3,5)+(3,6)+(4,5)+(5,5)+(5,4)+(3,4)+(2,3)+(2,0)+(1,0)+(1,3)+(-1,3)+(-1,0)+(-2,0)+(-
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2,3)+(-3,4)+(-5,2)+(-5,3)+(-3,5)+(3,5)

You can mix points and groups of points in the same function.

Regional Issues

If you use a comma as a decimal point (eg 3,2) you must use a semicolon to
separate the two coordinates.

(3;5)+(3;6)+(4;5)+(5;5)+(5;4)+(3;4)+(2;3)+(2;0)+(1;0)+(1;3)+(-1;3)+(-1;0)+(-
2;0)+(-2;3)+(-3;4)+(-5;2)+(-5;3)+(-3;5)+(3;5)

5.6.9 Vectors

Vectors are entered as <2,3>.  They can be added, subtracted and combined with
a point.  See regional issues

For example:
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(-2,-3) + <4,7> + <3,-3> - <4,0>

Constants

Vectors can contain constants which are discussed later in this manual.  You can
enter a vector of <-3a,b> for example.

Regional Issues

If you use a comma as a decimal point (eg 3,2) you must use a semicolon to
separate the two coordinates.

(-2;-3) + <4;7> + <3;-3> - <4;0>
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5.7 Function Reference



31FX Graph 3 Using FX Graph

© 1993-2004 Efofex Software

Command Description Exa
mpl
e

e constant e = 2.18281828… y =
e^x

pi constant p = 3.141592654… y =
pi x2

sin sine of an angle y =
sin
2x

cos cosine of an angle y =
cos3
x

tan tangent of an angle r =
2tan
th

asin or sin-1 arcsine or inverse sine y =
asin
(x)
y =
sin-
1(x)

acos or cos-1 arccosine or inverse cosine as
abo
ve

atan or tan-1 arctangent or inverse tangent as
abo
ve

sec secant of an angle y =
sec2
x

cosec cosecant of an angle as
abo
ve

cot cotangent of an angle as
abo
ve

cosh hyperbolic cosine y =
cosh
x

sinh hyperbolic sine y =
sinh
x

tanh hyperbolic tangent y =
tanh
x

ln natural logarithm y =
ln(2
x)

log base 10 logarithm y =
log(
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5.8 Points of Interest

FX Graph finds most points of interest for you - automatically.  You do not need to
"do" anything - just move the mouse around the graph.  Any points of interest will
be marked and a short message giving the coordinates and why it is "interesting".
All of the points in this diagram have been found automatically and displayed by
hovering the mouse over the point.

5.9 Right Clicking

Much of FX Graph's functionality is accessed by right-clicking.

· If you right click on blank space, the Quick Entry screen is displayed.
· If you right click on a function, a mini-menu is displayed.
· If you right click on an integral, annotation or tangent line, you can edit their

properties.
· If you right click on the axes, the axes screen is displayed (this feature can be

disabled in Tools/Preferences)
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5.10 Select Mode

Select Mode is the basic mode of FX Graph.  You can choose select mode by
pressing the  button on the toolbar.  When in select mode, you can select most
objects in a graph.

5.11 Moving Around The Plane

You can move around your axes using the arrow keys on your computer.  If we
have a set of axes such as

pushing the right arrow a few times will result in
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We have moved to the right.  If we push the right arrow a few more times we will
see

FX Graph will break the scale (if you have allowed it to) and move further to the
right of the plane.

You can use all four arrow keys to move anywhere on the plane.
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The Home Key

Pressing the home key at any stage will return you to the origin.

5.12 Zooming

FX Graph's Point of Interest system greatly reduces the number of times you will
wish to zoom into a graph but FX Graph supports zooming in a number of ways.

5.12.1 Zooming with the Keyboard

You can zoom in and out using the keyboard.

Starting Axes

Page Up - Zooms OUT by 33%
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Page Down - Zooms IN by 33%

5.12.2 Zooming with the Mouse

5.12.2.1 Zoom Mode

Before using your mouse to zoom, you must first enter Zoom  Mode.  Push the 

button on FX Graph's toolbar.  The cursor will change to to remind you that
you are using Zoom mode.

Once in Zoom mode you can use the mouse to Zoom into and out from functions.

5.12.2.2 Click Zooming

If you click the left mouse button somewhere on the plane, FX Graph will zoom
into the point you click on.  This allows you to quickly and easily zoom in on points
of interest.

5.12.2.3 Rectangle Zooming

If you sweep out a rectangle while holding down the left mouse button, FX Graph
will zoom into the rectangle you have defined.

5.12.2.4 Right Click in Zoom Mode

FX Graph remembers the axes' settings as you zoom in.  If you right-click while in
Zoom mode, FX Graph will go back one step.  This is sort of an "undo" for zoom.

5.13 Domains

Domains can be entered for most functions using one of two formats.

1. Using greater than, less than, greater than or equal to and less than or
equal to signs.  These are typed after a semicolon (or colon if you use a , as a
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decimal point) after the function when entering functions in the Quick Entry
screen.

For example:

By pushing the function button, you can see the domain of the function as a
separate entity.



38FX Graph 3 Using FX Graph

© 1993-2004 Efofex Software

2. You can also enter domains using bracket notation, (-2,3] for example.
Parentheses indicate > or < and square brackets £ or ³.  This style of domain
is quicker to use and does not require a semicolon (or colon).

For example:
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Constants

Domains can contain constants which are discussed later in this manual.  You
can have a domain of [-3a,b) for example.

Regional Issues

If you use a comma as a decimal point (eg 3,2) you must enter domains either as

x2 : -2<=x<2
or

x2  [-2;2)

5.14 Default Domains

If you have not explicitly set a domain, FX Graph will choose one for you.

Cartesian and inverse graphs have a domain implied by the size of the axes and
FX Graph will automatically draw a graph for this implied domain.

Polar and parametric graphs have no implied domain so FX Graph uses:

Polar graphs 0 £ q £ 360 (degrees mode)
0 £ q £ 2p (radian mode)
0 £ q £ 400 (grad mode)

Parametric graphs 0 £ t £ 20

If your polar or parametric graph is incomplete, you may need to set your own
domain.

5.15 Constants

5.15.1 Entering Constants

FX Graph understands seven constants.

Fixed Constants

e ~ 2.718281828
pi ~ 3.141592654

These constants can be used in functions, axes, domains, points and vectors.

Variable Constants

Variable constants (now there is an interesting concept - they probably should be
called parameters) allow you to examine how changing numbers in a function
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affects the function's shape.

FX Graph reserves a, b, c, d and m as constants that can be included in
functions.  They are entered in the same way as the variables x, y, r, t and th.

For example, you can enter the following function

y = ax2 + bx + c

and examine how changing a, b and c affects the parabola.

5.15.2 Changing Constants

When FX Graph detects a constant in a function, it automatically adds a constant
controller to the bottom of its screen.  FX  Graph adds one constant controller for
each constant.

Let's look at a constant controller in more detail.
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The top two buttons control the constant.  Pushing the up arrow will increase a
from 1 to 1.1.  Pushing the down arrow will decrease it to 0.9.

The step buttons allow you to control how much a is changed each time.  At the
moment the step is 0.1.  Pushing the up arrow will increase it to 0.25.  Pushing
the down arrow will decrease it to 0.05.

You can also type new values for a and Step directly into to the boxes.

We will discuss Families of Curves and Animations later in the next sections.
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5.15.3 Families of Curves

Entering y = ax2 into FX Graph gives you the following screen.

Pushing the Family of Curves button

allows you to set the start, finish and step for a family of curves.
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Here we can see all the parabolas in the family:  -5x2, -4x2, -3x2, -2x2, -1x2, 0x2, x2,
2x2, 3x2, 4x2, 5x2,

5.15.4 Animations

A constant in a function can be animated - changed over time.  Using the
parabola from the last section, this time push the Animation button
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You will see the following screen.

This is very similar to the Family of Curves screen, the only differences being the
Speed bar and Reverse.  Speed controls the speed of the animation.

Put in your settings and push OK.  FX Graph will animate your function by
changing a and regraphing the curve.

If you used the settings above, FX Graph would replace a with

-5, -4, -3, -2, -1, 0, 1, 2, 3, 4, 5, -5, -4, -3, -2, -1, 0, 1, 2, 3, 4, 5, -5, -4, -3, -2, -1...

Notice that when FX Graph gets to 5, it starts again at -5.  Checking the Reverse
box forces FX Graph to animate slightly differently.

-5, -4, -3, -2, -1, 0, 1, 2, 3, 4, 5, 4, 3, 2, 1, 0, -1, -2, -3, -4, -5, -4, -3, -2, -1, 0, 1, 2,
3, 4, 5, 4, 3, 2, 1, ...

Instead of starting again at -5, FX Graph counts down in Reverse, back to -5.

Brain Drain

Animating functions in FX Graph is very computationally intensive because FX
Graph has so much to calculate each time.  Intercepts, maxima and minima,
integrals, derivatives... everything is recalculated.  This means that on slower
computers, the animations may not be as fast as you would like.

Stopping an Animation

You can stop an animation by left-clicking anywhere on the graph.

Animation with Multiple Constants

If you have more than one constant, you can change the other constants during
the animation.  Try animating the c constant in y = ax2 + bx + c.  While the
animation is running, change a and b.
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5.16 Inequations & Feasible Regions

5.16.1 Entering Inequations

Inequations are entered by replacing the = sign in your equation by either,

>, <, >= or <=

Inequations can be entered for all function types except parametric.

x + y <= 4

r > 2 sin th

xy2 >= yx2 + 4

y >= 2x-7

x > 0

FX Graph will produce a shaded graph depending on your Feasible Region
Options.
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5.16.2 Feasible Region Options

On many occasions, you will be entering a number of inequations and trying to
identify the region that satisfies ALL the inequations - also known as the feasible
region.

FX Graph can show the feasible region in a number of ways - depending on your
needs.  The feasible region options can be changed by opening the Quick Entry
screen
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and pushing the More>> button.
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The Feasible Region options are described in the next sections.

5.16.2.1 Half Planes or Feasible Region

When graphing multiple inequations, FX Graph can graph each as a half plane,
or combine the inequations and shade ONLY the feasible region.

For example, if we graph  2x + y <= 8  and x + 2y <= 10

Half Planes

Shading half planes

When shading half planes, FX Graph shades the region which satisfies each
equation INDIVIDUALLY.  In the above example, the region which satisfies both
inequations has been shaded twice.  FX Graph uses each function's color for its
shading.
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If you prefer, you can set FX Graph to shade the half plane that does NOT satisfy
the inequation.  This option is available by choosing Preferences from the Tools
menu.

Only Feasible Region

Shading ONLY feasible region

In the second graph, FX Graph has calculated the region which satisfies BOTH
inequations and has shaded just that region.  This is often more clear.  The area
is shaded using the color selected in the Quick Entry screen.

5.16.2.2 Solid Shading
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Solid Shading

Solid shading is one block of solid color.  Solid shading has the advantage of
being faster to calculate and displays better on some devices.  FX Graph uses
solid shading when you have allowed it to and when the system of inequations is
not too complicated for its systems.
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Dotted shading

Uses an array of dots.  FX Graph tests an array of coordinates and determines
whether each point satisfies all inequations.  Any points which satisfy all
inequations are displayed.  Dotted shading is a more robust approach - the
complexity of the regions does not matter - but it is computationally intensive and
does not display as well on some devices.

FX Graph will use dotted shading when the system of inequations is too
complicated to solve.  For example,
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5.17 Derivative Curves

Cartesian functions can displayed with their first and second derivative curves.

 

To draw derivative curves for a function you have two options.

Right Click

If you right click on an existing function you will see this mini-menu
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You can select 1st and 2nd derivative curves on this mini menu.

Functions Screen

You can access the Functions Screen from the Quick Entry screen or by
choosing Edit Properties on the mini-menu above.

5.18 Integrals

FX Graph can graph integrals for any Cartesian function.

5.18.1 Using Your Mouse to Create Integrals

5.18.1.1 Integral Mode

Before using your mouse to create an integral, you must first enter Integral Mode.

Push the  button on FX Graph's toolbar.  The cursor will change to to
remind you that you are using Integral mode.

Integral mode is only available if you have entered a function that FX Graph can
integrate.

Once in Integral mode you can use the mouse to create integrals.



55FX Graph 3 Using FX Graph

© 1993-2004 Efofex Software

5.18.1.2 Integral Below One Curve

To sketch an integral below one curve, make sure you are in Integral mode.
Move your mouse until the start point of your integral is shown.  I have picked the
x intercept but I could also have picked any point on the curve.  The important
thing is to wait until FX Graph gives you a message indicating it has found the
function.

Click and hold the left mouse button, now move the mouse towards the end point
of the integral.  FX Graph will shade the integral as you go.
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Release the mouse button when you have reached the end point of the integral
and FX Graph will shade the integral for you.
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If you move the cursor over the integral and "hover", FX Graph will display the
details of the integral.
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5.18.1.3 Integral Between Two Curves

To create an integral between two curves using the mouse, your first click must
be on an intersection between the two curves.

Move until the point of intersection has been found
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If you start your integral now, the integral will be between the two curves.

I Don't Want My Integral to Start at the Intersection!

Then either create your integral with the mouse, starting at the intersection, and
edit the start point later OR create the integral using the Tools menu.

5.18.1.4 Multiple Integrals

If you use the mouse to create an integral and then try to create a second
integral, FX Graph will delete the first integral and replace it with the second.  If
you wish to create more than one integral, hold down the Ctrl key while creating
the second integral.

5.18.1.5 Integral to y Axis

You cannot create an integral (or area) to the y axis using the mouse.  You can
either create it to the x axis using the mouse and edit the integral later or you can
create the integral using the Tools menu.
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5.18.2 Editing Integrals

You can edit any integral by right clicking on it.

You can change the Functions that the integral is between and the Bounds of the
Integral.  The Swap buttons swap the two functions or bounds.  Delete will delete
the integral you are editing and you can change the colour of the shading.

The right hand Function is interesting as it allows you to find the integral between
a function and the x axis or y axis. Just select from the list.

Show Area if Different allows for situations such as the integral of sin x from 0 to
2p.  The integral is 0 but the area is 4.  FX Graph can show this if you allow it.
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5.18.3 Integral from Tools Menu

You can create an Integral directly, without the mouse, by choosing Integral from
the Tools menu.  When you do this you will see the same screen as when you
edit an existing integral.

5.19 Tangent Lines

FX Graph can attach Tangent Lines to any Cartesian function.

5.19.1 Using Your Mouse to Create Tangent Lines

5.19.1.1 Tangent Line Mode

Before using your mouse to create a tangent, you must first enter Tangent Line
Mode.  Push the  button on FX Graph's toolbar.  The cursor will change to

to remind you that you are using Tangent Line mode.

Tangent Line mode is only available if you have entered a function that FX Graph
can attach a tangent line to.

Once in Tangent Line mode you can use the mouse to create tangent lines.

5.19.1.2 Tangent Line on a Curve

Attaching a tangent line to a function is easy.  Just click on the curve you wish to
attach the tangent line to.  BEFORE you click, make sure that FX Graph has
found the curve.  You will know it has found the curve when it displays the curve's
definition.
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5.19.1.3 Moving a Tangent Line

You can move a tangent line on a curve by selecting it and using the left and right
arrow keys to move it.

First, select the tangent line.  You can do this when you are in select mode or
tangent line mode.  When the tangent line is selected, it will be drawn as a thicker
line.

You can now press the left and right arrow keys to move the tangent line.  The
annotation will be updated automatically.
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5.19.1.4 Multiple Tangent Lines

FX Graph will normally only allow one tangent line to be attached to a particular
function.  If you wish to attach more tangent lines to a function, hold down the Ctrl
key as you click on the curve.
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5.19.2 Editing a Tangent Line

You can edit a tangent line by right-clicking on it.

Here you can change the function, the location and the style and weight of a
tangent line.

5.19.3 Tangent Lines From the Tools Menu

You can create an Tangent Line directly, without the mouse, by choosing Tangent
Line from the Tools menu.  When you do this you will see the same screen as
when you edit an existing tangent line.

5.20 Annotations

Annotations are messages added to your graph.  FX Graph annotations have the
following features

The anchor line, anchor point and border are all optional.
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5.20.1 Annotation Mode

Before using your mouse to create an annotation, you must first enter Annotation
Mode.  Push the  button on FX Graph's toolbar.  The cursor will change to

to remind you that you are using Annotation mode.

Once in Annotation mode you can use the mouse to create annotations.

5.20.2 Basic Annotations

You can add basic annotations anywhere on the screen.

Annotation Without an Anchor

Just click on the screen and "blank" (it actually says "Right Click to Edit")
annotation will appear.

Annotation With an Anchor

Sketch a line with the left mouse button clicked.  FX Graph will create an
annotation with an anchor.
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5.20.3 Annotating Automatically

As you move around a graph, FX Graph will constantly give you small messages
describing what is under the mouse.  The messages may be the equation of the
function, a point of interest, details of an integral or the location of an asymptote.
If you left-click while one of these messages is on screen, FX Graph will create an
annotation at the same location with the same information.  This feature means
that most annotations in FX Graph are created automatically!

Some of the annotations created this way will have their anchors locked to a
point.

5.20.4 Moving Annotations

You can move annotations in Select Mode or Annotation mode

Left click on the annotation or the anchor and move them to their new location.

Note:  The anchors of some automatically generated annotations are not movable
as they locked onto a point on a function.
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5.20.5 Editing Annotations

Right-click on the annotation to edit it.

Anchors link the annotation to a point.  You can turn off the anchor or have it
show as an arrow, point or line.

You can have up to ten lines of information in your annotation and each line has
an Equation Check Box next to it.  This check box tells FX Graph how to interpret
the information you have entered (or FX Graph has automatically generated for
you).  The first of our two lines is an equation so we have placed a tick in the box
next to it to force FX Graph to display it that way.  This annotation will appear as

The Edit Annotation screen also has a More>> button.



69FX Graph 3 Using FX Graph

© 1993-2004 Efofex Software

This lets you set the style of the anchor line, the border line and the shading in
the rectangle.  You can also set the justification style.

5.21 Greater Control

The Quick Entry screen allows you to construct graphs quickly and efficiently - but
sometimes you will want more control.  You can access these extra controls
through the Quick Entry screen and right-clicking.

Functions Push the Functions button on the Quick Entry screen or right
click on the function you wish to edit and choose Edit
Properties.

Axes Push the Axes button on the Quick Entry screen or (optionally)
right click on the axes in Select Mode

Grid Push the Grid button on the Quick Entry screen

5.21.1 Functions

To access the Functions Screen, either right click on the function you wish to edit
and choose Edit Properties
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Or open the Quick Entry screen and push the Functions button

The Function Properties screen will open.
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Function Entry

Enter functions in the function section in exactly the same manner as in the Quick
Entry screen EXCEPT that the domain is now separated from the function for
clarity.

Domain Entry

Domain entry using either the -2 <= x < 3 format or the [-2, 3) format.

Asymptotes

FX Graph calculates vertical asymptotes using both algebraic and numerical
methods.  Horizontal asymptotes are calculated numerically and are not quite as
reliably detected as vertical asymptotes.  These check boxes allow you to turn on
display of these asymptotes.

Marks

FX Graph can draw domain marks and arrows on functions.  FX Draw will draw
an open circle for any < or > domain and a filled circle for any <= or >= domain.  It
can also draw arrowheads where ever the function leaves the plane.  You can
turn off these marks here.
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Derivative Curves

FX Graph can draw the first and second derivative curve for any Cartesian
function.

Function Curve Properties

Change the line style, weight and colour for the selected function.

Function Number

Using the Quick Entry screen, you can edit all ten functions at once.  The
Function Properties screen only displays the properties for one function at a time.
You can look at the other functions by changing the function number.  The up and
down arrows allow you to cycle through the numbers or you can type the function
number directly in.
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5.21.2 Axes

5.21.2.1 Setting Axes in the Quick Entry Screen

The quickest and easiest way to set axes is on the Quick Entry Screen.

First - set the shape of the axes using the axes shape scroll bars.  The centering
buttons return the axis back to the middle.  This makes it easy to get graphs such
as

Second - set the x and y maxima - everything else is automatic

Note, setting an x maximum in terms of pi (eg 2pi) will force FX Graph to write the
x axis scale in terms of pi.
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Autoscale is discussed later in this section.

5.21.2.2 Axes Properties Screen

To access the Axes Properties Screen, open the Quick Entry Screen and push
the Axes button

or (optionally) right click on the Axes when you are in Select mode.  This option is
controlled by the Tools/Preferences screen.

The Axes Properties screen will open.



75FX Graph 3 Using FX Graph

© 1993-2004 Efofex Software

5.21.2.2.1  Axis Control

This part of the screen allows you to explicitly control the x & y Axes maximum
and minimum.  Entering a maximum, minimum or tick in terms of pi forces
FX Graph to mark that scale in terms of pi.

You can also explicitly control the major and minor ticks for each axis.

Minor ticks - small axis marks and no numbers
Major ticks - large axis marks and numbers

Before you can adjust the major and minor ticks, you must uncheck the box next
to adjustments to ensure that FX Graph realises that you are taking responsibility
for these settings.



76FX Graph 3 Using FX Graph

© 1993-2004 Efofex Software

5.21.2.2.2  Scale Type

FX Graph can produce three different scale types.

Free Scales

Free scales fill the available area using your maxima and minima.  One unit on
the x axis is very unlikely to be the same measurement as one unit on the y axis.
For example, if we have a set of axes from -10 to 10 and draw them as free
scales, the graph might look like this.
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Equal Aspect

Equal aspect scales ensure that one unit on the x axis is the same measurement
as one unit on the y axis.  Using the same example, our graph might look like this.
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Equal aspect scales are important for many graph types - especially polar.  If you
are not using equal aspect scales, many graphs just do not "look" right.

It is possible to get exact aspect scales to "fill the available rectangle".  This is
discussed in Tools / Preferences.

The equal aspect setting is ignored if your Cartesian function contains
angle functions (eg sin, cos, tan) and you are not graphing in radians.

Fixed Scales

Fixed scales allow you to specify an exact number of millimetres per unit.  This
allows you to match existing graph paper for example.

Resizing

When you select Equal Aspect or Fixed Scales, FX Graph will produce a graph to
your exact requirements.  If you then place that graphic into another product (eg
Word) and resize it, FX Graph has NO control over the output and your
requirements will NO LONGER be met.  It is much better to generate the exact
graph you require inside FX Graph.
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5.21.2.2.3  Axis Styles

You must push the More >> button to access these settings.

You can change the line type and colour for each axis.  You can also turn OFF
the scale, the ticks and the axis.  This allows you to draw graphics without any
axes if you wish.

You can also change the fonts for the axis.
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5.21.2.2.4  Break Types

You must push the More >> button to access these settings.

FX Graph will break scales if you allow it.

There are a number of different break styles available.

FX Graph will break the scale whenever the minimum value for an axis is greater
than 0 or the maximum value is less than 0.

5.21.2.3 AutoScale

If the AutoScale box is checked on the Quick Entry screen, FX Graph will
automatically detect any points of interest (local maxima and minima, x intercepts
and intersections) from -500 to 500 and adjust the axes so that all of the points of
interest are visible.  Once you have selected Autoscaling, FX Graph takes full
responsibility for the axes.  Please note that the autoscaling feature slows
down the response time of FX Graph.

5.21.3 Grid

You can access the Grid Properties screen by pushing the Grid button on the
Quick Entry screen
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Note:  No matter what changes you make to the Grid Properties, NOTHING
will be shown unless you tick the Show Grid box on the Quick Entry screen.

The Grid Properties' layout depends if you have set the grid to show as lines or
points.

Grid Lines Properties
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Grid Point Properties

Using the various sections you can change the style, weight and color of the lines
and points.

Polar Grid

By checking the polar grid box, you can draw polar grids of lines or points.  The
number of rays determine how many radii emerge from the origin.
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6 Preferences

Different locations around the world have different preferences - their graphs look
different.  FX Graph can support these differences and most differences are set in
the Preferences page of the Tools menu.
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Preference settings are global - they will affect any open graph and any graph you
create.

Note:  Preference settings can be "locked" to prevent changes by students.  More
details can be found in FX Graph's installation notes.

6.1 Axes

6.1.1 Mark Origin

This option allows you to mark the origin of your set of axes with a small circle
(the radius is set here).
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6.1.2 Show Negative / Positive Arrows

Different places in the world have different preferences for their axes.  Some like
arrow heads, some do not.  Some like arrow heads only on the positive axes.
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6.1.3 Blank Under Scale

When you add a grid to a set of axes, the lines of the grid interfere with the scale.
FX Graph will blank out an area of the grid before it writes the numbers of the
scale and this prevents the grid making the scale hard to read.  The blank under
scale setting lets you turn off this feature.  The two graphs below show you the
result.  The first graph has Blank Under Scale on, the second graph has it off.
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6.1.4 Fill Rectangle

Fill Rectangle only has an effect if you have chosen Equal Aspect axes.  Imagine
that you have asked FX Graph to draw Equal Aspect axes and you want both the
x and y axis to go from -10 to 10.  This will produce a "square" set of axes.
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If you are using this set of axes in a normal FX Graph window, FX Graph must
add white space to each side of the graph to keep this square shape.

If you turn Fill Rectangle on, FX Graph will fill the sides with more of the axes - it
uses your -10 to 10 settings as a MINIMUM requirement.  The axes are still equal
aspect but you do not have this wasted space at the side.
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6.1.5 Break Width & Height

Break width (w) and height (h) are in millimetres and control how FX Graph draws
break marks for broken scales.  All break marks use these numbers in the
drawing - not just the parallel line break mark shown here.

6.1.6 Axis Tick Size

Axis ticks are the marks on the scale.  The Axis Tick Size (h on diagram) is
measured in millimetres and is height above the x axis of a major tick.  The minor
tick is automatically half this size.
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6.1.7 Arrow Size

Arrow Size (measured in millimetres) controls the size of the arrow heads at the
ends of the axes.

6.1.8 Tick Style

This preference controls how the ticks are drawn on the axes.  The various
options are best shown in a diagram.

6.2 Feasible Region

6.2.1 Shade Accept Region

When shading the feasible region for an inequality, some locations shade the
region that AGREES with or accepts the inequality.

y >= x
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and some schools shade the region which disagrees with or does not accept the
inequality

y >= x
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If you tick Shade Accept region, y >= x will produce the first graph.

6.2.2 Dot Density

FX Graph will often shade feasible regions with an array of dots.  The greater the
number of dots, the more solid the shading - but the slower the calculations.  A
dot density of 200 (the default) will produce acceptable results on most computers
but you can decrease the density on slower computers or increase it on faster
computers.

6.3 Functions

6.3.1 Domain Size

Sets the size of the domain end points.  The size is the radius of the circles - in
millimetres.
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6.3.2 Discontinuity Size

Some functions have point discontinuities (see example below).  FX Graph
automatically finds these point discontinuities for rational functions and displays
them with a small circle.  This preference controls the radius of the circle (in
millimetres).
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6.4 General

6.4.1 Key Zoom Ratio

Pushing the Page Up and Page Down buttons will zoom the axes in FX Graph.
This number determines the ratio that the scale is increased or decreased by.

For example, the default Key Zoom Ratio is 1.33333.  If you axes have maxima of
10 and minima of -10, pushing the Page Up button will change the maxima to
13.33333 and the minima to -13.33333.

6.4.2 Replace +- on Display

FX Graph can accept +- (±) characters in equations.

For example, if you enter y = x+-3 you will see this graph.
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The two parts of this function are each labelled with two annotations.  The upper
annotation retains the ± character with a positive or negative arm message.  This
is how FX Graph reports functions when Replace +- on Display is OFF.  The
lower annotation, where the ± character has been replaced by either + or - as
appropriate, is how FX Graph reports these functions with Replace +- on Display
ON.
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6.4.3 Right Click on Axes

Usually, right-clicking in the FX Graph screen will start the Quick Entry screen but
if you right click on an axis, FX Graph will start the Axes properties screen.  Some
people dislike this behaviour and find it distracting.  You can turn it off here.

6.5 Annotations

Annotations have a number of adjustments that can be edited here.  There
settings are:

1. Anchor Gap - the gap between the border and the beginning of the anchor
line.

2. Corner Offset - As you move an annotation around, the anchor stays attached
to a corner but this setting lets it float down the side of the border.

3. Arrow Size
4. Point Size
5. Border Gap - Between the border and the text.

7 Messages

FX Graph 3 displays many messages on screen - things like "Point of
Intersection".  By going to the Tools menu and choosing Messages, you can
change the messages FX Graph provides.
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You can also change the default number of decimal points that FX Graph uses
when displaying the points.  This is important because some routines (eg Point of
Inflection) are not as accurate as others.
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